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1 Introduction
1.1 Preface
Keep these Operating Instructions in a place that is accessible to all users at 
all times.

Please assist us to improve these Operating Instructions, where necessary.

Your suggestions will be appreciated.

Phone +49 661 6003-0 
Fax +49 661 6003-607

1.2 Typographical conventions

1.2.1 Warning signs

The signs for Danger and Caution are used in this manual under the following 
conditions:

Danger

This symbol is used where there may be danger to personnel if the 
instructions are disregarded or not followed accurately!

Caution

This symbol is used where there may be damage to equipment or data if the 
instructions are disregarded or not followed accurately!

Caution

This symbol is used where special precautions must be taken when handling 
electrostatically sensitive components.

1.2.2 Note signs 

Note

This sign is used to draw your special attention to a remark.

Reference

This sign refers to additional information in other manuals, chapters or 
sections.

 
abc1

Footnote

Footnotes are comments that refer to specific parts of the text. Footnotes 
consist of two parts: a marking in the text, and the footnote text.

The marking in the text is arranged as continuous superscript numbers.

B
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1 Introduction
 
 
h

Handling instructions

This symbol marks the description of a required action.

The individual steps are indicated by the asterisk, e.g.

h Press the h key

h Confirm with E

1.2.3 Presentation  

 
 
h + E

Keys  

Keys are shown in a box. Both symbols and texts are possible. If a key has 
multiple functions, then the text shown is the one that corresponds to the 
function that is active at the moment.

 
Program 
Manager

Screen texts

Texts that are displayed in the program are indicated by italic script.

 
Edit ! 
Instrument data

Menu items

The menu items in the program are shown in italics. Menu name, menu item, 
and sub-menu item are separated from one another by “!”.

1.3 Hardware and software requirements
The following hardware and software conditions must be fulfilled for the 
installation and operation of the evaluation program:

- IBM-PC or compatible PC, with Pentium and above

- 16 MB main memory

- 3.5" diskette drive

- CD-ROM drive  
(for installation, and to create a set of diskettes)

- Mouse

- VGA graphics

- Windows 95/98/NT 4.0

recommended 
minimum 
configuration

- Pentium 200

- 32 MB main memory

- 200 MB free space on the hard disk
4



2 Guide
2.1 Introduction
On the following pages is a guide which should clarify the principles of the 
PCA evaluation program.

For a better understanding, the concept is explained by analogy with the 
present chart recorder and the paper rolls with the process data.
5



2 Guide
2.2 Store measurement data
This chapter explains how paperless recorder measurement data is read into 
and stored on your PC. For a quicker access to the subsequent visualization, a 
concept based on an archive and an evaluation was chosen. 

The Archive represents the conventional storage of the paper rolls and the
Evaluation represents the unrolled paper roll.

Practical experience has shown that most users only want to store (archive) 
the measurement data initially, and only take data from an archive later for 
analysis,  e.g. in the event of a fault.

H The archive concept is arranged such that the data of several instruments 
can be stored.
6



2 Guide
The communications server offers a further possibility for storage of measure-
ment data. 

v Section 5 “Communications server”

H Evaluation of the measurement data (unpacking) can take several min-
utes with extensive measurements. At this time, the data is unpacked to 
approximately 8-times the data quantity. To save memory space, only 
data which will be analyzed in the foreseeable future should be evaluated 
(unpacked).

Archiving
+

Evaluation

Archiving

Diese Disketten

sind nicht

entpackt

Archive

Recorded
time periods

archived period 1

archived period 2

archived period 3

archived period 4

archived period 5

archived period 6

archived period 7

archived period 8

archived period 9

archived period 10

archived period n

These time periods

have not been

unpacked

Evaluation

Unpacked data for the
archived time period

Archiviert und
ausgewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Archiviert und
ausewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Period 2
– archived and
evaluated
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Evaluation

The evaluation comprises only the

storage of the unpacked records

(corresponds to the rolled-up chart

rolls).

They must be opened for visualization.

Section 2.3.2 “Open Evaluation”v
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2 Guide
2.3 Visualize measurement data

H Measurement data which are to be visualized are opened from the Evalu-
ation. 
If these measurement data are not yet available in the Evaluation, they 
must first be unpacked from the archive. This process is carried out via 
the  Prepare menu item.

Prepare Evaluation

Evaluation ... Prepare selects measurement data

from the archive, unpacks them, and stores them

in the evaluation.

These data can also be from different paperless

recorders (different systems).

Section 2.3.1 “Prepare Evaluation”v

Prepare Evaluation

Copy

Evaluation

Unpacked data for the
archived time period

Archiviert und
ausgewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Archiviert und
ausgewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Archive

Recorded
time periods

archived period 1

archived period 2

archived period 3

archived period 4

archived period 5

archived period 6

archived period 7

archived period 8

archived period 9

archived period 10

archived period n

These time periods

have not been

unpacked

Period 2
– archived and
evaluated
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2 Guide
Visualization

Evaluation ... Open

Evaluation ... Open opens selected

measurement data from the evaluation, and

visualizes them.

Section 2.3.2 “Open Evaluation”v

Open Evaluation
9



2 Guide
2.3.1 Prepare evaluation

H Measurement data which are to be visualized can only be opened from 
the  Evaluation. 
If these measurement data are not yet available in the Evaluation, they 
can be unpacked from the archive into the evaluation via the Prepare 
Evaluation menu item. This process corresponds to unrolling the con-
ventional paper roll.
10



2 Guide
 
 
 
 
 

In the form the selected set of data can be moved from
the time period in the archive to the time period in the evaluation.

Evaluation ... Prepare,

h
h
h

h

Select device
Select the time period in the archive
Use the         button to move it to the evaluation time period

Confirm with OK

If several time periods (diskette) and their data are read in from one device, then
a separate entry is made in the time window for each time period (diskette).
However, a precondition is that the configuration of the paperless recorder is not
altered. Every alteration of the configuration results in the creation of a new
device.

Info

Evaluation
Unpacked data for the
archived time period

Archiviert und
ausgewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Archiviert und
ausgewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Period 2
– archived and
evaluated
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

H The time periods are copied into the evaluation by clicking on OK, i.e. no 
time periods are erased from the archive through “Prepare evaluation”.
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2 Guide
2.3.2 Open Evaluation

Evaluation 
Open

Measurement data are opened and visualized from the evaluation via Evalua-
tion Open.

Open Evaluation

1.

Evaluation

Unpacked data for the
archived time period

Archiviert und
ausgewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Archiviert und
ausgewertete
Diskette (Disk 2)
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

Period 2
– archived
and evaluated
11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

11010011

01111010

00101110

11101101

10110001

10001110

11011100

11010011

01111010

00101110

11101101

4.

3.

2.
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2 Guide
In the form, the desired
device and the corresponding group for the
device are selected and then visualized.

Evaluation ... Open

1. Select device
2. Select group
3. Restrict time period (if required)
4. Confirm with OK

Up to 6 groups can be stored in the paperless
recorder. These are then visualized individually
here.
If the observer wishes to present together
channels that are selected from different
groups, then this can be done be creating a
PCA group
(menu item: ).

Info

Evaluation ... PCA group

Visualization

H If an archive contains data over a very long period (e.g. 1 year), it is rec-
ommended that the least data possible is copied into the time period of 
the evaluation, so that a fast screen display is ensured. The more data 
there are in the time period of the evaluation, the longer is required for the 
screen display.
13



2 Guide
2.4 Store measurement data on any path
You have the possibility of storing your measurement data in various directo-
ries. That offers the advantage that your data can be filed e.g. sorted by year 
or by places of measurement (see example), or are accessible by other people 
on a network (Windows NT or Novell).

Change the 
standard 
setting

Customer setting

C

Measure

JUMO

Program Files

Works1

JUMO-PCA

Works2

Works3

Archive

Archive

Archive

Archive

Evaluate

Evaluate

Evaluate

Evaluate

Standard setting
14



2 Guide
h Call up the Defaults item in the Extras menu bar.

h In the Defaults form, change to Directories.

h You can search for the desired path by activating the  button. A new 
target directory can be set up by using the right mouse button or 
in the Windows Explorer.

h Click on  to accept the setting.

H Only one path can be selected for archive/evaluation!

Standard setting

Customer setting
15



2 Guide
2.5 Archive and evaluation directories

Archive 
directory

The archive directory can be located on a network. Joint use of one archive 
from several PCs is permissible. 
 
If several users share one archive directory and if this directory is accessed by 
a number of PCs simultaneously, all the PCs should have been set to the same 
time. If there are significant differences between time settings (more than 6 
minutes), problems may arise with the management of user interlocks.

Evaluation 
directory

We do not recommend that the evaluation directory is located on a network. 
However, if this is the case, take care that the data are only accessed by one 
user at a time.

Important 
notes

- Manipulations (e. g. deleting files and subdirectories) must under no circum-
stances be carried out in the archive or evaluation directory, but only via the 
PCA program.

- Data backups of archive directories must always contain the complete ar-
chive directory. Never make partial backups from the directory.

- When data are recorded on a CD, each file automatically receives the at-
tribute “write protected” (read only).  
When the data are copied from the CD to the hard disc, the file attribute 
“write protected” must be manually reset. This can be done under Windows 
using the explorer, for example, or the command Attrib. 
Start Attrib in Windows with Start ! Run: 
 
attrib  -r  “Directory of archive”\*.*  /s 

A If these notes are disregarded, loss of data may result.
16



3 Evaluation
3.1 Introduction

The Evaluation menu allows the graphical display of measurement values 
which are read out from the paperless recorder, either via a diskette or via the 
communications server. The menu consists of the following functions:

- Prepare... 
with the aid of the Prepare... function, data which are to be graphically 
displayed are selected from an archive.

v Section 3.2 “Prepare evaluation”

- Open  
with the aid of the Open function, the selected data are graphically 
displayed. 

v Section 4 “Open evaluation”

- Close 
close the open evaluation - finish graphic.

- Reset 
clear data from the evaluation. The data archive remains unaffected by this 
action.

- PCA group 
generate local groups (with up to 36 channels).

- Import version 108.01.XX... 
import data of an older PCA program.
17



3 Evaluation
3.2 Prepare evaluation
After the Evaluation ➔ Prepare function is called up, the dialog window 
described below appears.

Instrument
All available instrument  
configurations are displayed 
here. A configuration 
is selected using the mouse 
or the keyboard.

Periods in archive
all available time periods (measurement data) of an instrument 
configuration are indicated here. A time period is selected using the 
mouse or the keyboard.

Supplementary description
with the aid of this button, the 
“Supplementary description” 
of the selected configuration 

can be edited

Select periods
with the aid of these 

two buttons, time periods 
 are copied between 

 archive and evaluation

Periods in evaluation
all time periods indicated here can 
be graphically displayed
18



3 Evaluation
Procedure  To prepare data of an instrument configuration for evaluation (graphical 
display), the following steps should be carried out:

h using the mouse (or keyboard) select an instrument configuration from the 
list (all available time periods of the archive are shown automatically).

h using the mouse (or keyboard) choose a time period in the archive.

h copy the time period into the evaluation using the  button.

h finish the preparation with . 

All necessary archive data are now prepared and can be graphically displayed 

afterwards, using the menu functions Evaluation ➔ Open or using the  
button.
19



3 Evaluation
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4 Open evaluation
4.1 Introduction

After calling up the Evaluation ➔ Open function or pressing the  button, an-
other dialog window appears before the graphical display, by which the select-
ed time period can be further restricted. The fewer measurement data are 
used within a graphic, the clearer and faster it will be.

Group The Group window only contains selection options for data of paperless re-
corders with an instrument software version starting with 100 (e.g. 100.02.01). 
In the case of recorders which do not have a group distinction, the field re-
mains empty.

Instrument
All available instruments are dis-
played here. The selection is made 
via the mouse or the keyboard.

Group
The groups contained in the 
selected instrument are dis-
played here.

Time period (maximum)
The maximum time period of 
the selected evaluation is  
displayed here.

Time period (current)
The time period which  
is to be displayed  
is set here.
21



4 Open evaluation
4.2 Selected time period
There are two ways to limit the time period:

- by direct input using the cursor keys and numeric keypad

- via a dialog, which is opened by clicking the left mouse button on the  
field 

When the desired time period has been selected, the measurement data can 

be graphically displayed by calling up the  button.

H Only dates within the selected time period can be selected.

Day
Select the desired day using 
the mouse or the cursor keys 

Year
The desired year is 
selected here by a  
mouse-click

Month
The desired month is 
selected here by a  
mouse-click

Month
Select 

previous month

Month
Select 
next month
22



4 Open evaluation
4.3 Evaluation

This display is accessed via Evaluation ➔ Open or the  button. Before the 
graphical display, a dialog window appears, which can be used for further lim-
iting of the selected time period. The fewer measurement data used within a 
graphic, the clearer and faster it will be.

More detailed information on time period selection is provided in Section 4.1 
“Introduction” and Section 4.2 “Selected time period”.

The display is divided as follows:

- a graphics area, in which the measurements are displayed, and

- a table area, which serves to control the graphic and other functions.

open evaluation
close evaluation

print current window (e.g. channels or periodic report)
use left mouse button to zoom in X-direction

use left mouse button to zoom in Y-direction
use left mouse button to zoom in X- and Y-direction

use left mouse button to set guidelines
reset zoom

zoom forwards (zoom in)
zoom backwards (zoom out)
23



4 Open evaluation
4.4 Graphics area
The graphics area is shared by the analog and digital signals.The analog sig-
nals always lie above the digital signals.

The most important control element within the graphic is the mouse, with the 
aid of which various functions can be performed.

Left  
mouse button

The left mouse button is reserved as standard for the zoom function in the di-
rection of the X-axis.

h position the mouse pointer within the graphic

h press and hold the left mouse button

h move the mouse to mark the range which is to be magnified

h release the mouse button

The graphic is automatically magnified to the next possible area. As a result of 
this, PCA expands the selected ZOOM range further, so that one of the time 
periods listed in the following table is used as the interval between the divi-
sions in the graphics area. 
This action is similar to setting the chart recorder feed rate in sec/DIV  
or min/DIV. 
If the complete time period is displayed, setting of the division units is sup-
pressed, so that the whole of the graphics area can be used to display the 
graph. In addition, setting of exact division units facilitates simple and fast
scrolling by page or by division within a zoomed time period.

When using the Y-zoom, it should be noted that the channels which do not 
have a Y-axis or an auxiliary Y-axis will be zoomed in a fixed ratio to the main 
Y-axis. As a result of this action, the scaling range of the auxiliary Y-axis or 
channels with no Y-axis is expanded under certain circumstances. This en-
sures a fixed ratio to the main Y-axis.  
24



4 Open evaluation
Thanks to this, diagram graphs appear after the Y-zoom in the same ratio to 
one another as before the ZOOM.

Possible time periods per division on the x-axis: 
1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 15, 20, 30, 40, 45 seconds 
1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 15, 20, 30, 40, 45 minutes 
1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 12, 15, 20 hours 
1, 7, 14, 60, 180, 365, 730, 1825, 3650 days

Possible range per division on the y-axis: 
1, 2, 5, 10 in the corresponding  resolution of the power of 10

Right  
mouse button

If the right mouse button is pressed when the mouse pointer is within the 
graphic, a dialog window appears in which various functions can be selected.

Batch search After calling up the function, a list of the available batch records appears (only 
if the batch records were activated when the paperless recorder was config-

ured). Select a batch and press . The associated batch data will be 
automatically displayed over the entire width of the x-axis.

Additional functions:

-  Reduce list of available batches

-  Display batch text of selected batch

Batch info The function shows the batch text of the displayed batch. It is only available if 
the data of a specific batch has been brought into the display using the Batch 
search function 

Zoom forwards Using Zoom forwards, the next zoom display can be produced again. This 
function is only available if a Zoom backwards has been performed. As an al-
ternative to the mouse, Zoom forwards can also be performed from the PC 
keyboard (Page Up).

Zoom back-
wards

Using Zoom backwards, the previous zoom display can be produced again. 
The function is only available if a zoom has been carried out. As an alternative 
to the mouse, Zoom backwards can also be performed from the PC keyboard
(Page Down).
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4 Open evaluation
Reset  
zoom

Reset zoom displays the entire time period of the selected evaluation again. 
As an alternative to the mouse, Reset zoom can also be performed from the 
PC  keyboard (Home).

Print After calling up the Print function, a sub-menu with additional functions ap-
pears:

- Print preview 

- Print

- Printer setup

Print !  
Print preview

The printout of the graphic can be previewed on screen.

Print !  
Print

This function starts the printer output.

Print !  
Printer setup

Using this function, various printer properties (e.g. paper size and paper orien-
tation) can be taken into account.

Characteristics After calling up the Characteristics function, a dialog window appears. Using 
the adjustable parameters, the graphical display and the function of the left 
mouse button can be influenced.

H To be able to zoom using the PC keyboard, the graphics area must 
be the active window. If the table area is the active window, the 
mouse must first be clicked in the graphic.
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4 Open evaluation
Character- 
istics ! 
Display ratio

No change to the settings is posible here. The data display is created auto-
matically, with the “depending on the X-axis zoom” setting.

Character- 
istics ! 
Actions of left 
mouse button

This feature fixes the function of the left mouse button within the graphic. With 
the standard setting, the left mouse button effects a zoom in the X-axis direc-
tion. 

If the “Guideline” setting is chosen, a vertical and a horizontal line appear 
when the left mouse button is pressed (incl. the current values of amplitude
and time). The associated measurements are displayed in the table area (Table
Channels must be active). 

The guideline can also be moved from the PC keyboard using the key combi-
nations  Shift-Cursor left or Shift-Cursor right.

Character- 
istics ! 
Font size

This setting allows the size of the scaling of the X- and the Y-axis to be 
changed.

Character- 
istics ! 
Zoom

This setting can be used to influence the marking of a range to be expanded. 
Either continuous marking (any) or marking at fixed intervals (divisions) can be 
selected.

Character- 
istics ! 
Increase speed

The “Do not display measurements” and “Do not draw in background” func-
tions are not checked with a  as standard, i.e., they are active. The number 
of measurements which can be displayed on the screen is limited to 200 per 
channel.

H The positioning of the guideline occurs with reference to the “actu-
al measured values”, i.e. it can deviate from the visual course of 
the graph if there are more measured values than are actually dis-
played.

H The functions of the left mouse button can also be operated via the 
toolbar of the software. 

Zoom X-axis
Zoom Y-axis

Zoom X+Y-axis
Guideline
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4 Open evaluation
Do not display measurements

If the mouse pointer is placed on a measurement within a graphic and not 
moved any more, a window appears with the current values of amplitude and 
time. 

After a few seconds the window disappears again. By turning off the ( ) func-
tion, the evaluation program has fewer arithmetic tasks to perform and is 
therefore slightly faster.

Do not draw in background

With the standard set up, the picture for the user is not visibly prepared and 
then suddenly introduced (drawn in background). By selecting “Do not draw in 
background” the graphic is displayed on line on the screen. The line of the 
graph can be followed as it is “drawn”. This form of display is slightly faster 
than a display in the background.

The difference between the two display forms is only significant with very large 
quantities of data.

Maximum number of displayed measurements per channel

The figure selected here (10 — 10 000) sets the number of measurements to 
be displayed per channel. The higher the figure is, the more measurements are 
displayed in the graphic. The lower the figure is, the fewer measurements are 
displayed.

Character- 
istics ! 
Display all mea-
surements

Only every nth measurement will be displayed as standard (according to the 
zoom factor). This also applies to the print preview and the printout. By check-
ing the the “Printout” und “Print preview” tick boxes you can force all meas-
urements to be printed or displayed.

H Caution: If too small a number of measurements is selected, the 
graphic may well be faster, but the line of the graph can only be 
partly made out with reference to the actual measurements.
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4 Open evaluation
4.5 Table area
The table area serves to control the graphic and other functions. Its operation 
is based on spreadsheet calculation programs. The area consists of several 
registers, which are introduced or removed depending on availability. The 
maximum available are:

- Channels

- Periodic report*

- Daily report*

- Monthly report*

- Yearly report*

- External report*

- Batches*

- Events

- Analog: Groups...

- Digital: Groups...

- Logbooks for electrode and measuring cell calibration2 

1 These tables are only available for recorders with an instrument software version starting with 
    100 (e.g. 100.02.01).

2 These tables are only available for recorders with an instrument software version starting with 
    163 (e.g. 163.01.01).

The right mouse button also has a special function in the table area. After 
pressing the right mouse button, a dialog window appears with functions 
which vary depending on the active register. The one single function which can 
be called up in all registers with the aid of the right mouse button is the Print 
function.

v Section 4.5.8 “Print”

Click here to introduce further 
registers (if available)

Active register

Click here to select register as 
active register
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4 Open evaluation
4.5.1 Channels

Peak value 
display

On paperless recorders with an instrument software version that does not
start with 100, two measurement curves are always available. The LOW curve 
includes the data for the acquisition types average value, momentary value, 
minimum value, maximum value, and the minimum value for peak value meas-
urement. The HIGH curve only contains the maximum values for peak value 
measurement.

Display channel

Line type

Channel description
End of scale

Channel color

Start of scale

Group name

Channel name

Y-axis type

Ratio of displayed measurement 
to actual measurement

Display of 
channel unit

Line thickness 

Maximum values as a separate curve

Minimum values as a separate curve
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4 Open evaluation
Functions of the left mouse button

Display 
channel

Each channel can be introduced or removed. Only channels which are marked 
by a   are displayed in the graphics area.

Channel color The color in which the measurements and channel-related data are displayed 
is selected here. The selection affects both the graphic and the table area.

Line type The type of display (specific to each channel) is selected here.

Line thickness The line thickness for the representation of the curve can be selected here.

Y-axis type The type of axis for a channel can be selected here. The choices available are:

- Main Y-axis 
It should be noted here that there can only ever be one channel with a main 
Y-axis. The Y-axis is located on the left-hand edge of the screen.

- Auxiliary Y-axis 
The auxiliary Y-axis is located to the right of the main Y-axis. The scaling of 
the data is adapted to the main Y-axis.

- No Y-axis 
No Y-axis is displayed for the selected channel.

Displays (not directly changeable)

Ratio of 
displayed 
measure- 
ments ...

The current display factor is displayed here. The factor changes when meas-
urements are zoomed.

Display of 
channel unit

The channel unit configured on the instrument appear here.

Channel name The channel name configured on the instrument appears here.

Group name The group name configured on the instrument appears here.

Start of scale The start of scale configured on the instrument appears here.

Point+Line Line Stepped line
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4 Open evaluation
End of scale The end of scale configured on the instrument appears here.

Channel  
description

The channel description configured on the instrument appears here.

Functions of the right mouse button

In the channels register, the function of the right mouse button is simply to 
print out the graph of the displayed measurement.

More detailed information on the Print function is given in Section 4.5.8 “Print”.
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4 Open evaluation
4.5.2 Report

The table is only available for paperless recorders with an instrument software 
version starting with 100 (e.g. 100.02.01).

The  report register (statistics) differentiates between:

- Periodic report

- Daily report

- Monthly report

- Yearly report

- External report

The individual registered reports for all channels are shown, including period, 
minimum, maximum and average value.

Functions of the left mouse button

With the aid of the left mouse button, the column width and row height can be 
altered within the report register.

Alter column width:

h Position the mouse between two columns 

h With the left mouse button pressed, alter the column width by dragging the 
mouse

h Release the mouse button

Alter row height:

h Position the mouse between two rows 

h With the left mouse button pressed, alter the row height by dragging the 
mouse

h Release the mouse button

The left mouse button also serves to mark a range. With the aid of the right 
mouse button these marked ranges can be exported in Excel 97 or text format 
using the “Export” function.

Mark range:

h Position the mouse in an entry

h With the left mouse button pressed, select a range by dragging the mouse

h Release the mouse button
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4 Open evaluation
Mark column:

h Position the mouse in the column heading ( )

h Press the left mouse button

Mark row:

h Position the mouse in the left-hand column of the row ( )

h Press the left mouse button

Additional keys:

With the aid of the shift key and the left mouse button, a range covering sever-
al rows/columns can be marked. Using the control key and the left mouse but-
ton, additional rows/columns can be marked.

Functions of the right mouse button

The following dialog window appears when the right mouse button is pressed 
(the mouse pointer must be in the table area).

Zoom time 
range

The measurements of the selected report are zoomed to the next displayable 
area and graphically displayed.

Scroll time 
range

If the start time of the report does not lie in the visible area, e.g. after a zoom, 
the graph can be shifted using “Scroll time range”, so that the start time (or the 
next possible) lines up with the left hand border of the window.

Synchronize 
time range to 
diagram

The entry in the table area which corresponds to the displayed measurement 
is searched for and started. The time information at the left-hand border of the 
window is important here.

Mark all All table data are marked.

Copy The marked data is copied onto the Windows clipboard and can therefore be 
imported, e.g. directly into Excel 97.

Export Using the “Export” function, data can be stored in either Excel 97 or Text (*.txt)
format, and subsequently processed further. Export of measurements takes 
place oriented by row. If a column is marked, the measurements of the other 
columns will be exported as well.

v Section 4.5.9 “Data export into Excel 97”

Print v Section 4.5.8 “Print” 
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4 Open evaluation
4.5.3 Batches

The table is only available for paperless recorders with an instrument software 
version starting with 100 (e.g. 100.02.01).

All recorded  batch files are listed in this  register.

Functions of the left mouse button

Within the batch register, the column width and row height of the individual 
listings can be altered using the left mouse button.  
The left mouse button also serves to mark a range. With the aid of the right 
mouse button, these marked ranges can be exported in Excel 97 or text for-
mat (*.txt) using the “Export” function.

v Section 4.5.9 “Data export into Excel 97”

More detailed information on altering column width and row height as well as 
marking a range is available in Section 4.5.2 “Report”.

Functions of the right mouse button

The following dialog window appears when the right mouse button is pressed 
(the mouse pointer must be in the table area).

Zoom 
batch range

The measurements are zoomed to the next displayable area and graphically 
displayed.
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4 Open evaluation
Scroll 
batch range

If the start time of the batch data does not lie in the visible range, e.g. after a 
zoom, the graph can be shifted using “Scroll batch range”, so that the start 
time (or the next possible) lines up with the left-hand border of the window.

Synchronize 
batch range 
and diagram

The entry in the table area which corresponds to the displayed measurement 
is searched for and started. The time information at the left-hand border of the 
window is important here.

Search batch The “Search batch” function allows specific batch files to be found. The 
search can be made easier by selecting various criteria. If no criteria are given, 
all batch files will be searched.

Before a search criterion can be fed in, it must be activated. Active search cri-
teria are recognizable by the check .

Continue batch 
search

The “Continue batch search” function, which is only available after a “Search 
batch” function has been carried out, repeats a defined search for specific 
batch files.

Batch  options The list of available batches can be reduced by using “Batch options”.

Before an option can be fed in, it must be activated ( ).

Batch info Using “Batch info”, the batch information of the selected batch is displayed. 
Using the ENTER, ESC keys, or by clicking on the  button, the information 
window is closed again.

Mark all All table data are marked.

Copy The marked data is copied onto the Windows clipboard and can therefore be 
imported, e.g. directly in Excel 97.

Export With the aid of the “Export” function, data can be stored in either Excel 97 or 
Text (*.txt) format, and subsequently processed further.

Export of measurements takes place oriented by row. If a column is marked, 
the measurements of the other columns will be exported as well.

v Section 4.5.9 “Data export into Excel 97”

Print More detailed information on the Print function is available in Section 4.5.8 
“Print”.
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4 Open evaluation
4.5.4 Events

Functions of the left mouse button

Within the events register, the column width and row height of the individual 
listings can be altered by using the left mouse button.  
The left mouse button also serves to mark a range. With the aid of the right 
mouse button these marked ranges can be exported in Excel 97 or in text for-
mat (*.txt) using the “Export” function.

v Section 4.5.9 “Data export into Excel 97”

More detailed information on altering column width and row height as well as 
marking a range is available in Section 4.5.2 “Report”.

Functions of the right mouse button

The following dialog window appears when the right mouse button is pressed 
(the mouse pointer must be in the table area).

Scroll event 
time

If the event time does not lie in the visible range of the diagram, e.g. after a 
zoom, the graph can be shifted using “Scroll event time”, so that the time (or 
the next possible) lines up with the left hand border of the window.

Synchronize 
event time and 
diagram

The entry in the table area which corresponds to the displayed measurement 
is searched for and started. The time information at the left-hand border of the 
diagram window is important here.

Event filter The list of displayed events can be reduced by using “Event filter”. 

For example, if the “System Messages” field is deactivated ( ), then, amongst 
others, the “New configuration” as well as the “Power on” and “Power off” 
messages will not be displayed.
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4 Open evaluation
Mark all All table data are marked.

Copy The marked data is copied onto the Windows clipboard and can therefore be 
imported, e.g. directly into Excel 97.

Export With the aid of the “Export” function, data can be stored in either Excel 97 or 
Text (*.txt) format, and subsequently processed further.

Export of measurements takes place oriented by row. If a column is marked, 
the measurements of the other columns will be exported as well.

v Section 4.5.9 “Data export into Excel 97”

Print More detailed information on the Print function is available in  
Section 4.5.8 “Print”.
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4 Open evaluation
4.5.5 Analog: Groups...

The measurements of the analog inputs are listed in this register.

<<<< = below measurement range       >>>> = above measurement range

Functions of the left mouse button

Within the analog data register, the column width and row height of the individ-
ual listings can be altered by using the left mouse button.  
The left mouse button also serves to mark a range. With the aid of the right 
mouse button these marked ranges can be exported in Excel 97 or text format 
(*.txt) using the “Export” function.

v Section 4.5.9 “Data export into Excel 97”

More detailed information on altering column width and row height as well as 
marking a range is available in Section 4.5.2 “Report”.

Functions of the right mouse button

The following dialog window appears when the right mouse button is pressed 
(the mouse pointer must be in the table area).

Scroll time If the measurement for a date/time does not lie in the visible area, e.g. after a 
zoom, the graph can be shifted using “Scroll time”, so that the time (or the 
next possible) lines up with the left-hand border of the window.

Synchronize 
time with 
diagram

The entry in the table area which corresponds to the displayed measurement 
is searched for and started. The time information at the left hand border of the 
window is important here.
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4 Open evaluation
Mark all All table data are marked.

Copy The marked data are copied onto the Windows clipboard and can therefore be 
imported, e.g. directly into Excel 97.

Export With the aid of the “Export” function, data can be stored in either Excel 97 or 
Text (*.txt) format, and subsequently processed further.

Export of measurements takes place oriented by row. If a column is marked, 
the measurements of the other columns will be exported as well.

v Section 4.5.9 “Data export into Excel 97”

Print More detailed information on the Print function is available in Section 4.5.8 
“Print”.
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4 Open evaluation
4.5.6 Digital: Groups...

The measurements of the digital inputs are listed in this register.

There are the same functions and possibilities as in the register for analog 
measurements.

v Section 4.5.5 “Analog: Groups...”
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4 Open evaluation
4.5.7 Logbooks for electrode and measuring cell calibration

The tables are  only available for recorders with an instrument software version 
starting with 163 (e.g. 163.01.01).

A separate logbook is displayed for each electrode or measuring cell that is 
connected. The following was used in the display example:

- Logbook 2: pH

- Logbook 3: free chlorine

- Logbook 4: chlorine dioxide

The following is entered in the logbook with each alteration of the calibration 
values: 
date, time, evaluation of the electrode or cell, calibration, calibration condi-
tions and the new calibration values.

Functions of the left mouse button

The left mouse button is used to alter the column width and the row height of 
the individual entries within the logbook register.  
In addition, the left mouse button also serves to mark a range. The right mouse 
button is used to export these marked ranges in Excel 97 or text format (*.txt) 
using the “Export” function.

v Section 4.5.9 “Data export into Excel 97”

Further information on altering the column width and the row height, as well as 
how to mark a range can be found in Section 4.5.2 “Report”.
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4 Open evaluation
The functions of the right mouse button

The following dialog window appears when the right mouse button is pressed 
(the mouse pointer must be within the table area).

Roll time 
range

If the start time of the logbook entry does not lie within the visible range, e.g. 
after a zoom, the curves can be shifted using “Roll time range”, so that the 
start time (or the next possible) lines up with the left-hand border of the win-
dow.

Synchronize 
time range to 
diagram

The entry in the table area which corresponds to the displayed measurement 
is looked up and started. The time information at the left-hand border of the 
window is essential here.

Mark all All table data are marked.

Copy The marked data are copied to the Windows clipboard and can therefore be 
imported, e.g. directly in Excel 97.

Export Using the “Export” function, data can be stored in either Excel 97 or text (*.txt) 
format and subsequently processed. Export of measurements takes place 
row-oriented. If a column is marked, the measurements of the other columns 
are exported as well.

v Section 4.5.9 “Data export into Excel 97”

Print Section 4.5.8 “Print” 
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4 Open evaluation
4.5.8 Print

When the “Print” function is called up, the following dialog window appears in-
itially.

Print preview The “Print preview” function permits a document to be previewed on screen 
before it is printed. Depending on the active register, further selection possibil-
ities appear before the print preview, e.g. which data should be displayed.

Print Starts the print process. Please note that when the display is zoomed, several 
pages may be printed out.

Header /  
Footer

Headers and footers can be defined here. Any character strings and instru-
ment-specific variables are available.

Instrument-specific variables are introduced by a “$”- or by a “#”-sign. 

Select font name and size

Set first page 
number

Set cells for text and 
 control elements

Set paper margins

Switch over to header 
area
44



4 Open evaluation
The following variables are available:

Within the “Batch” register appear:

Page setup The “Page setup” function offers additional control of the visual appearance of 
the print out.

Printer setup The “Printer setup” function calls up a dialog window from Windows, in which, 
amongst others, the paper format and the paper orientation (portrait, land-
scape) can be selected.

$P Current page number

$N Number of pages

$D Current print date 
(time and date)

$D{%d.%m.%y} Current print date 
(date only)

$F Evaluation name

$A Program name

$R Register name

#DEVICE Device name

#DESCRIPTION Additional description

#GROUP Group name

#TIME Current time

#DATE Curent date

#START_TIME Start time of the evaluation

#START_DATE Start date of the evaluation

#STOP_TIME End time of the evaluation

#STOP_DATE End date of the valuation

#CHARGE_LEFT0 … 
#CHARGE_LEFT9

Batch data name

#CHARGE_RIGHT0 … 
#CHARGE_RIGHT9

Batch data
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4 Open evaluation
4.5.9 Data export into Excel 97

Data export into Excel1 is explained in more detail in this section by means of 
an example.

Export as a data 
file

h Open the evaluation via the Evaluation ➔ Open menu or by pressing the  
button.

h Activate the Analog: Group 1 register by clicking on it with the left mouse 
button.

h Mark a range by holding down the left mouse button and moving the 
mouse downwards over the row numbering. Release the mouse button 
when the desired range is marked.

h Press the right mouse button and call up Export and then Excel 97 (*.xls).

h In the following dialog choose Selected measurements and confirm with 
OK.

1. Excel is a registered trademark of the Microsoft Corporation

Row numbering
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4 Open evaluation
h In the dialog window which follows, the path can be selected and the file 
name entered,  under which the data will be stored in Excel format.

After successful storage the data file can be opened using Excel.

Further proces-
sing with 
Excel

h Start Excel and open the previously stored data file. Normally, an empty 
worksheet (table 1) will be opened. Change to the  required worksheet 
(e.g. Group1_1).   

h Mark the data to be converted (e.g. a column).

h The Text Assistant must be started via the Excel Data ➔ Text in columns... 
menu.

h By selecting Fixed width and operating the END button, transfer the data 
into a number format.  The data are now available for graphical display or 
calculation.

Export by text 
file (*.txt)

Export to Excel using a text file is particularly useful with older versions of 
Excel.

h Within the PCA program, export the data into a text file.

h Start Excel (e.g. Version 5.0).

h Open the generated text file via the File ➔ Open menu 
(File type = Text file).

h In the Excel Text Assistant, steps 1 to 3 are confirmed with “Further”.

h During steps 2 to 3 the field-separator “Tab” must be deactivated and the 
“Comma” activated.

h Quit the Text Assistant with “End”.

Now the data of the text file is also available for a graphical display or for cal-
culation.

A The data file cannot be stored if the data file already exists and is open at 
the same time in Excel.

H At the beginning of the data file is a 8-digit header followed by the 
measurement data. The total length (header and data) can not ex-
ceed 65536 rows. If there are more measurement data than this in 
the PCA evaluation program, they are automatically divided into a 
number of tables.

If the data in Excel is to be graphically displayed or calculated, it 
must first be converted.
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4 Open evaluation
Export via  the 
clipboard

There is a further option of importing data into Excel by using the left mouse 
button within the various tables of the PCA evaluation program.

h Open the evaluation via the Evaluation ➔ Open menu or by operating the 
 button.

h Activate the Analog: Group 1 register by clicking on it with the left mouse 
button.

h Mark a column by moving the mouse over the column title (e.g. Chan. 1) 
and pressing the left mouse button.

h Call up the “Copy” function using the right mouse button. The data are now 
stored on the Windows clipboard.

h Start Excel, open a worksheet, and insert the data in the worksheet with the 
aid of the Excel  Edit ➔ Insert menu.

H When data are exported via the clipboard, the data are directly available 
in number format and need not be converted using the Excel Text Assist-
ant.
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5 Communications server
Section 2.2 “Store measurement data” has already described how 
measurement data can be read into a PC and archived. A further possibility is 
to use the communications server program, which is supplied as an option. It 
is available for reading measurement data out of the paperless recorder via the 
serial interface (RS232, RS422 or RS485).

Compared to data storage on diskette, the communications server has the ad-
vantage that the measurement data of one or more recorders can be automa-
tically archived at specific times. So it is conceivable that data backup could 
take place during the night or at other break times. In addition, larger time pe-
riods can be generated using the communications server than with the disket-
te.

As a prerequisite for operating the program, the paperless recorder used has 
to be fitted with a serial interface.

Further information about the communications server program can be found in 
the Operating Instructions B 95.5098.
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6 Appendix
6.1 PC keyboard
 

Table 1: Keys within the graphic

Key (key combination) Function

Home Take zoom back

End Restore previous zoom setting

Page Up Zoom forward

Page Down Zoom backwards

Cursor left Scroll time period to left

Cursor right Scroll time period to right

Ctrl-Cursor left Scroll time period to left 
(by one complete window width)

Ctrl-Cursor right Scroll time period to right 
(by one complete window width)

Shift-Cursor left Shift guideline to the left

Shift-Cursor right Shift guideline to the right

Shift-Ctrl-Cursor left Shift guideline to the left

(larger step width)

Shift-Ctrl-Cursor right Shift guideline to the right

(larger step width)

Table 2: Keys within the register

Key (key combination) Function

Cursor left Move left one column

Cursor right Move right one column

Page Up Turn over to next page of list

Page Down Turn back to previous page of list

Ctrl-Home 1 Jump to the first column of the first 
list entry

Ctrl-End Jump to the last column of the last 
list entry
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6 Appendix
6.2 Tips and Tricks
- A time adjustment (e.g. summer time/winter time) should only be made 

when PCA and the communications server are not running. 
If the clock is put back by 1hr, all instruments with a short cycle time  
(e.g. hourly or shorter) should be read in once manually (using the 

 button in the unit list), as otherwise the next read event moves 

back by 1hr. After the read-in, the communications server accepts the 
current time again.

- The automatic adjustment facility from summer time to winter time should 
not be used, as under certain circumstances the data for the additional 
“changeover hour” cannot be evaluated by PCA.

- Before accessing the hard disk, PCA and the communications server, 
check that at least 10MB of free disk space is available. However, this 
check cannot safeguard all possible system configurations and PCA 
applications. 
 
For this reason, when working with PCA or Windows, it is recommended 
that approx. 100 MB of free hard disk memory is available in the program 
directory.
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7 Index
A
alter

column width 33
row height 33

archive 6

B
batches 25, 35

C
channel 30
channel color 31
channel, displaying 31
copy 34

D
data export 46
display ratio 27

E
evaluation 6, 8, 10, 17–18
evaluation ... open 12, 21, 23
export 46

F
filter 37
font size 27

G
graphics area 23–24
graphics characteristics 26

K
keyboard 51
keys 4

L
line thickness 31
line type 31
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7 Index
M
mark

column 34
range 33

measurement data, archiving 6, 49
measurement data, saving 6, 49
measurement data, visualizing 8
minimum configuration 4

N
note signs 3

O
open evaluation 12

P
peak value display 30
prepare 8
presentation 4
print 26, 44

S
screen texts 4
scroll 34, 36–37, 39
search 36
speed 27
synchronize 34, 36–37, 39, 43

T
table

analog data 39
batches 35
channels 30
digital data 41
events 37
report 33

table area 23, 29
time period 22
tips and tricks 52

Y
Y-axis type 31
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7 Index
Z
zoom 23, 25
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